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I. Asighment

Software Product GOODLIFT —is an informational computer system, assigned for automatization of powerlifting
championships (according to the rules of IPF).

Il. Requirements to Hardware and Software

The Product is created to use of personal computers under the control of operating system Windows 98,
Windows 2000(XP). Also the Product, being included into the work of the computer network, uses protocol
TCP/IP.

II.1. Requirements to Hardware

The Server:
— the processor with clock rate not lower than 500MHz (not lower than 1GHz is recommended);
—the RAM not lower than 64 Mb (512 Mb and higher recommended);
—avideo card, supporting resolution of the screen not lower than 1024x768, 16-bit color palette;
— 20 Mb on the hard disk for the Product installation and also the size of the database (which is not lower
than 5 Mb).

The Client:
— the processor with clock rate not lower 300 MHz (not lower than 500 MHz is recommended);
—the RAM not lower than 64 Mb (128 Mb and higher recommended);
— a video card, supporting resolution of the screen not lower than 1024x768, 16-bit color palette (if the
computer provide the output of a video signal onto videoprojectional equipment, than the card should have
TV-output and provide the screen output with resolution not lower than 1024x768, 32-bit color palette);
— 10 Mb on the hard disk for the Product installation.

The Computer Network:
— the network supporting the protocol TCP/IP;
— network cards on each computer, working as a part of the network (1 Gbit cable network is strongly
recommended);
—network equipment, defined by the possibilities of the organization responsible for the holding of the
championships (topology of the network, the length of segment etc.).

Il. 2. Therequirements to Software

— installed operating system Windows XP (Windows 2000);

—installed program MS Excel (from MS Office 2000/XP/2003; but MS Office 7 not possible) — for formatting,
editing and printing of documentation (optional);

—the rest of product components are installed together with the Software Product GOODLIFT (Notes: to
avoid misunderstanding with another Software it is strongly recommended to install the Product on the
computers only with the Software mentioned above).

lll. Installation and setting of the Product

lll. 1. Installation of the protocol TCP/IP and setting of the IP-addresses

On the computer, which will be used in the network system, the network TCP/IP protocol must be
installed. For correct operation of the system it is recommended that IP-addresses should be set manually. It
is also recommended to install 192.168.0.X addresses, where X — is arbitrary integer digit from 2 up to 255
(different one for each computer which is a part of the network system) and a mask of the subnet
255.255.255.0 . IP-address 192.168.0.1 is recommended for the computer which works as the server of the
competitions (secretariat). For the rest of the computers — the last figure in the address 2, 3, 4 and so on
increase. Itis also recommended to assign computers the intelligent share names. To install the protocol and
to set the address are possible with the help of standard means, offered by Windows system: «Control
Panel» > «Network» > «Configuration» > «TCP/IP Protocol» > «Property».
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[ll. 2. Setting of Access Paths to the Database

The Product uses the database server Interbase. That's why this server must be run during setting and
operation of the Product. You can make sure the server is run by the sign in the try-area: @ . If the serveris
not run find the sign in the Desktop

@

fhserver

(it will appear after the installation of the product) and click on it two times. Thus the server will be run.
After the GOODLIFT installation on the Desktop there will appear a shortcut to run BDEAdmin

B2

BOEAMIN

Run it, and in the appeared window on the bookmark «Database» choose the database alias — goodlift. In
the window «Definition» for the parameter «Server name» set value: access path to the installed BD, for

example:
c:\Program Fil es\goodlift\db\goodlift.ib

Onthe computer-client before specifying the path to database file goodlift.ib, specify IP-address of the
competition server twice, for example:

192.168.0. 1:c:\Program Fi |l es\goodl i ft\db\goodlift.ib

It is also necessary to specify the value of USER NANME parameter: goodlift

. 3. Setting of Program-Client

At the first run of the program-client it is especially necessary to enter the value for the «Server para-
meters & IP-address» in the window «Options». In this field IP-address of the computer which is a Server
of the competitions is entered.

IV. PROGRAM-CLIENT GOODLIFT

IV. 1. The Run of the Program
After the program installation on the Desktop of the computer there will appear a shortcut

L

Client
After double click on it with the left button of the mouse there will be run the program-client. The window

of the program looks like:
a me a ®

[

state: client iz stopped
Picture 1
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After the click on the button the program begins to act and makes attempts to connect to the server

of the competitions. After the connection the window of the program looks like:

GOODLIFT ; Remote Client N3, Q)

C 10

state: connection is active

;J r

Picture 2

After this the program can work in a standalone state under the control of the commands which come
from the server.

For the quick run of the program-client it is enough to press the button , and then the button

@. After that the program will pass into the mode of search and be minimized into tray-area.

Possibleindication of the program state:

|<B—Qﬁ|@ 21:54  —the program is activated, the connection to the server is active.

|<B—Qﬂx 21:55  —the program is activated, the connection to the server is absent.

||<B—QE. 21:56  —the program is not activated.
Picture 3

When the program is in a minimized state, it is possible to cause the appearance of pop-up menu of
the program, having clicked o the icon of the program with the right button of the mouse. The following
commands are accessible in the menu:

show to show the window of the program;
start to activate the program-client;

stop to stop the program-client;

exit to cease the work of the program.

IV. 2. Setting of the Program-Client
You can also cause appearance of the option window of the program-client. To achieve this you must
press the button . After this there will appear the option window of the program-client (see Picture 4).

Parameters of the Program-Client:
Client Information:
Computer name — network address of the computer, on which the program is run.

Local IP-address — network address of the computer, on which the program is run.

Server Parameters:
IP-address — IP-address of the server of the competitions.

Client Parameters:
Show hints — to show the pop-up hints on the elements of interface.

-7-



GOODLIFT —USER'S GUIDE

GOODLIFT ; Remote Client Options g

Client information

Computer name: server
Local IP-address: 192.168.0.2

Server parameters

IP-adress 192.168.0__.2_

Client parameters

Show hints v
Show flags o
Show points

Region description |Nati0n

Presentation timer tick

Protocols timer tick 15 2

Picture 4

Show flags —to show flags in Lifting Order List.

Show points — to show in the protocols the places of the sportsmen taken by them in separate
disciplines.

Region description — to assign the title for a region destination (e.g.: Nation, Club etc.)
Presentation timer tick — to assign a time interval between slide showing in any sportsman pre-
sentation/introduction.

V. Competition Program-Server

QUESTION 1. How is the program-server run?
Answer. Find on the Desktop sign «Server»

M-
Server
and click on it twice with the left button of the mouse.

QUESTION 2. How is the system entered?
Answer. Choose the necessary level of privileges in the window of «Entering to the system», enter the
appropriate password and press the button «OK» (See Picture 5).

QUESTION 3. How are new competition created?
Answer. It's necessary to choose the menu item «Competition > New» or to press the button of quick

access |:| . In the appeared window (See Picture 6) enter the necessary information about the competition
and press the button «OK».
To the information about the competitions the following items are referred:
Competition name — the title of the competition;
Place and date competitions
Country — the host country;
City —the host city;
Date of competition —the date when the competitions are held,;

-8-
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GOODLIFT3 X

Access level

— <.y Administrator .
"_3% o d

S
| o
i)

Password

e |

Picture 5
New competition X
Competition name
[ |
Place and date of competition
Country City Date of competition
| |l | [01.11. 2005 v |- |01.11.2005 - |
Competition type
| juricrs | |% Y=y - | |'i' championzhip * |
’ W Yes ” 3 cancel ]
Picture 6

Competition type
the 1st field — ordinary competitions or among invalids;
the 2nd field — the age-group competitions among the youth, masters or open competitions;
the 3rd field — competitions among men or women;
the 4th field — selection of the Championships or competitions in bench press.

QUESTION 4. How are the existing competitions opened?
Answer. It's necessary to choose the menu item «Competition > Open» or to press the button of quick

access [T . Inthe appeared window (See Picture 7) choose the title of the competitions in the left panel and
press the button «Open».

QUESTION 5. How can the information about the current competitions be changed?

Answer. First, it's necessary to open the competitions, information about which should be changed
(See QUESTION 4). After than it's necessary to choose the menu item «Competition > Edit» or to
press the button of quick access & . There will open a window which is similar to the window which is
responsible organizing new competitions. It's necessary to change the appropriate parameters of the
competitions and press the button «OK».

QUESTION 6. What are the main combinations of keyboard’s keys while one is working with the

tables displaying the data?

Answer. To insert a new record the key «Insert» (INS) should be used. To delete the record
choose the note, you want to delete, with the cursor and press the combination of keys «Ctrl + Del»
— after the question «Delete record?» having appeared, press the button «OK», if you want to
delete the record, or the button «Cancel» if you don’t. To edit a record, choose the field with the
information to be edited and press the button «Enter» (or choose the necessary field with the help
of the mouse). Thus, the information can be edited just in the table or (for some kinds of information)

-9-
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Competition open

Competitions ~ -
European Masters Women's Championships | ’ B Edit ]
European Masters Men's Championships ’ @ Remove ]
3rd Student's World Cup Single Championships
3rd Student's World Cup Single Championships s
4th European Men Benchpress Open Championships
4th European Women Benchpress Open Championship
33th Open Men's World Championships

Competition host
Canube Cup Kolomyia (Ukraine)
Danube Cup

. . Competition date
25th Women's World Championships 03.07.2002 - 03.07.2002
34th Open Men's World Championships

15th World Open Men's Bench Press Championship
15th World Open Women's Bench Press Championship
5th Masters Benchpress Championships Men

5th Masters Benchpress Championship Women

2Z8th Men's European Open Championships

26th Women’s Warld Open Champicnships

Competition type
Women f Championships [ Masters

21s=t Junior's European Powerlifting Championships ’ &  Open ]
21s=t Junior's European Powerlifting Championships
S e . . l M cancel ]
World Sub-junior Powerlifting Championships v
Picture 7

special editors will open. Information is considered to be put down into database, if you've filled a
field with the information (or the whole record) and have left the input area (having clicked with the
mouse in any other field or having pressed the keys «Up Arrow» or «Down Arrow» on the keyboard
with the cursor). To cancel the input (if the information has not been recorded yet) one should
press the button «Esc»

QUESTION 7. What does it mean «field», «record»?

Answer. Thus, the record for the sportsman Beer will have four fields with the values: Beer;
Rosemarie; 82.5 kg; 2; and value of the field «First name» equals «Rosemarie» (See Picture
8).

s TN ~ T
(" RECORD (" FIEELD

S e S A

A Surname :I; First Mame Birthdate ﬁiﬁreightdass ﬂ'd-NaﬁDn;" Club
Beer Rosemarie |17.07.1945 82,5 kg Austria
Chepil Mariya 08.06.19/0 56 kg Ukraine
—
Picture 8

QUESTION 8. How is a sportsman who will take part in the current competition registered?
Answer. For this purpose it is necessary to open the main table of the competition, if it hasn't been opened
yet (menu item «View > Main Table» or the quick access button || ). After this one should insert a new

record into the table (to press the key «Insert» or with the help of the context menu — See QUESTION 10).
Being in the field «Surname» one can type the initial letters of sportsman’s surname. If the information about
the sportsman before, then the information about him will appear in the line of the record. Also one cam click
on the field «Surname» with the left button of the mouse, then click on the appears in the field

button | E3 and choose the necessary sportsman in the appeared list. After that one should

-10 -
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choose the weight category for the sportsman, and the region he will represent and finish editing of the record
(See QUESTION 6.). One can also input another information about the sportsman into the record.

Attention! The fields, marked by the sign of the yellow key in the headline, e.g. | /7. FirstName | must be

obligatory filled in. This information is used to hold the competitions and generate the documentation. If in
such a field the information is absent, the program will work incorrectly.

QUESTION 9. How is a sportsman registered in general database of the sportsmen?
Answer. It's necessary to choose the menu item «View > Sportsmen Table» or to press the button of quick
access. In the appeared window «Data Tables» choose the bookmark «Sportsmen» (if it hasn’t been already
chosen). In the appeared table insert a new record (see QUESTION 6) and enter the information about the
sportsman, namely:

Surname —field «Surname»;

Name —field «Surname»;

Data of Birth —field «Birthday»;

Sex — field «Sex» (value M—-W);

Personal best achievements in squat, bench press, dead lift and personal best of totals — PB

SQ, PBBP, PB DL, PB TOTAL;

Sportsman’s Photo —field «Photo»;

Textual information About the Sportsman —field «Text» (the photo and the text is used to present/

introduce the sportsmen before the competitions and may be not filled in).

QUESTION 10. The usage of contextual menu to work with the main table.

Answer. To add, delete or change information about a sportsman
in the main table of current competitions you may use the

| add sportsman contextual popup menu besides the keyboard. Choose
sportsman’s record, the information about whom you want to delete
% | Remove sportsman or change, click on with the right button of the mouse (to add a
Z7  Edit sportsman new recqrd click with the right button of the mouse in any place of
the working area of the main table). The view of the contextual

Picture 9 menu is displayed in Picture 9.

Choose the necessary item in the menu and click on it
with the left button of the mouse. To input the information
about the sportsman press the key «Insert» on the keyboard
or call a textual popup menu «Add sportsman» (See
Picture 9). There appears an empty line on which you should
click wit the left button of the mouse in the field «<Surname»
(or with the help of the keyboard «Enter > Alt + ~»). In such
a may a special referee editor will be shown, to give the
information about the registered referees in the general
database. In this editor choose the necessary referee with
the help of the mouse —the information about him will appear
automatically in the line for the following fields (Note: If you
haven’t found the necessary sportsman in the editor list —
choose the editor (% and input the information about sports-
man into the general database (See QUESTION 9). After this

retry). It's also necessary to define the sportsman «Weight
category and «Nation/Club» (Region). To perform this click

4 Cut Ctr+X

= on the fields «Weight class» and «Nation/Club» with the
5 Copy Ctr+C left button of the mouse and choose the necessary value from
B Paste MCtr+V the list.
¥ Delete
& Load... QUESTION 11. How is a photo or additional textual
H Save To... information about a sportsman added into general database
of the sportsmen?
Cancel Answer. Open the window «Data tables» (See Question
10) and edit the fields «Photo» and «Text» accordingly. If
Picture 10 these fields do not contain any information, then the stylized

pictures look like: =) (the picture is grey in

-11 -
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color; letter «a» is not capitalized). If the fields have any information then the pictures look like
s (the picture is colored; letter «A» is capitalized). Editor for sportsman’s photo has

either an empty working field (if the picture is not saved into database yet) or sportsman’s picture.
Picture field editing is done with the help of contextual popup menu (See Picture 10), which includes
the main instructions:

Cut — cut the picture into clipboard;
Copy - copy the picture into clipboard;
Paste — paste the picture from clipboard;
Delete — delete the picture;

Load - load the picture from the file;
Save — save the picture into the file.

Attention! After the work with the picture press the button «OK», if you want to commit the
changes, or the button «Cancel» if you don’t (don’t forget to leave the input field after this to save
the changes into database (See Question 6))

Operations with the textual field are the same (Note: As the text, which is to be saved into
database, is used in the mode of sportsman’s presentation, thus there are length and number of
the textual line restrictions. Try to input the lines in order to fill them in only into the editor field of
the editor without excluding its boundaries. In the other case while the text is being shown on the
screen in the presentation mode, formatting will fail and the text will be shown in parts.

QUESTION 12. How is the information about a Referee added into general database of Referees?
Answer. Open the window «Data tables» (See QUESTION 9), choose the bookmark «Referees» and
insert the record about referee into database. To perform it press the key «Insert» (INS) on the keyboard.
In the appeared line input the information into the definite fields:

Surname — the surname of the Referee

Name — his name

Region — the region (country, state, city etc.) the Referee is from
Rank —referee qualification (category of Referee).

QUESTION 13. How is the information about the Referees of the competition saved into database?
Answer. First of all, show the window «Referees». To perform this choose the menu item «Show > Referee
Table» or use «speed button» £l or press the combination of keys «Ctrl + R». there will appear the window
«Referees» (See Picture 11).

% Referees X
Category Surname Firstname Mation/City Duties La
44 kg Kuster Rudolf Germany Centerreferes
43 kg Mesterenko Oleksandr Ukraine Sidereferees
(352 kg Dekhanowv Alexander Russia Sidereferse
56 kg Minchenko Sergiy Ukraine Jury
60 kg Hofirek: Jiri CZzechia Jury
67,5 kg Muller Favaol Slovakia Jury
75 kg
82,5 kg
90 kg
S0+ kg
w
Cane ]
Picture 11

The window is divided into two panels: the left (painted) panel «Category» includes the names of
bodyweight categories, and the right (white) one includes the fields «<Surname», «First name», «Nation/

-12 -
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City» and «Duties». To input the information about the session competition Referees choose the name of
the bodyweight category , which is the last in the session, on the left panel (e.g. for the session: —=52kg, —
56kg, —60kg, choose —60kg), and into right panel add the records about the Referees. To perform this
make the right panel active (click on it with the left button of the mouse) and press the key «Insert» on
the keyboard or call a textual popup menu «Add referee» (See Picture 12).

There appears an empty line on which you should click wit the left button of the mouse in the field
«Surname» (or with the help of the keyboard «Enter > Alt + »). In such a may a special referee
editor will be shown, to give the information about the registered referees in the general database.
In this editor choose the necessary referee with the help of the mouse — the information about him
will appear automatically in the line for the following fields «Surname», «First name» and «Nation/
City» (Note: If you haven’t found the necessary referee in the editor list — choose the editor |x

and input the information about referee into the general database (See QUESTION 12). After this
retry). It's also necessary to define the referee duties he is to perform in the chosen competition

session. To perform this click on the field «Duties» with the left button of the mouse and choose
the necessary value from the list.

QUESTION 14. What are the general rules of work with the tables that display data?

Answer. The tables that are used in the GOODLIFT system may include such elements of control as
line, column, header of the table (See Picture 13).

SUB HEADER

¢ | Addreferee

8 | Remove referee A Surname Al First Name
Arakawa
Picture 12 Arvai

With the data displayed in the table the following operations are possible:

1) Sorting of the data by a definite field (column). To perform this move the mouse onto the column
header, in which the data should be sorted and click on it with the left button of the mouse. In he
column header will appear an arrow pointing up and the data will be sorted ascendantly. if the data
are necessary to be sorted discendantly click on the column header one mouse time — there will be
an arrow on the header pointing down and the data will be sorted discendantly (See Picture 14).
2) To delete sorting in a define column click on the header of this column with the left button of the
mouse with the key «Ctrl» being pressed on. You may also sort by several columns. To perform this
click on the headers of the necessary columns with the left button of the mouse with the key «Shift»
being pressed on (See Picture 14).

& sumame /| |& Surmame T |

Beretta Wiass

Bruder Taukanova & Sumame -+ |& Firstname ¢
Bruder Thirnrm Beretta Donatella
Casiraghi Szprmkoviiak Bruder Klathilde

Czecs Speth Eruder Manika
Eremenko Ponomareva Casiraghi Daniela

Gorte F.azhirina Czecs Brizka

Gosteva k.arbpzhewa

K.arbyshewva Gosteva

Picture 14

3) Grouping by define field (or fields. You may divide information into separate groups to perform grouping
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|&Natinn: |&NatinnIC|uh / |

Club #
_|| Biveight cla... + |
&  Surmame / |& Firsthame ¢

& Surname & |& Firstname / | [=] Mation/Club : Germaty

MationAClub : Germary Bruder Klothilde
Mation/Club : Great Britain Bruder W onik.a
. Czecs Brizka
eight clazs : 52 kg Speth Eva
| Caziraghi | Daniela | T hirrm Anita
(=] Weight class : B7.5 kg MationClub : Great Britain
| Beretta | Donatella |
Mation/Club : Poland MationAClub : Poland
Mation/Club : Russia MationClub : Bussia
Mation/Club : Ukraine Mation/Club : Ukraine

Picture 15

by a separate field (or by several fields — See Picture 15). To perform this move the cursor of the mouse
on the column header by which grouping is done, press the left button of the mouse and move the
column header onto the table header with the left button of the mouse being pressed on. To cancel
grouping you must return («drag») the column header back. When the data table is in the mode of
grouping you may show detailed data (all the data are shown) or shortened data (only the names of data

groups are shown). For this purpose use the button of quick access 2p <& or menu items

«View > Expand main table», «View > Collapse main table».
4) To organize the columns in another way «drag» a define column header with the information is
marked by green arrows (See Picture 16).

¥

= . i 1 SR ok

wstnagueai A Bineight class _____ | & Birthdate
atella 675 kg 201259
hilde Ak kg 1 11.10.56
1ka 52 kg 1 10.06.54
liela 52 kg 1 01253
ka a0 kg 1 07.05.57
tlana 56 kg 1 01.11.57
#ina B0 kg 2 221247
xrtina 52 kg 1 07.08.55
tandra 48 kg 1 24.04 56

Picture 16

QUESTION 15. How are division of the lifter flights into groups and loting done?
Answer. First you should call the form «Category Operations». This can be done via the main menu:
«Forms > Category Operations»; using the «short» combination of the keys «Ctrl + Alt + C»; or by means of
the «speed» button.
The form «Category Operations» is divided into two parts. There is a list of the lifters in its left part, where the
following parameters of the lifters are given: their weight class, nomination total and some fields to be filled in
with the number of the group and lot of a lifter. In the left part are the elements of control: a list of weight
categories, elements to choose an operation type from (Grouping and Lotting), an information area, and the
buttons to start an operation (or close a form) with and to return to the main form of the programme.
To divide the flights into groups one should:
1. Check the necessary categories (which are included into a separate flight) in the list of categories.
2. Choose the operation type «Grouping». Choose the number of groups to be divided (see picture 17).
3. Control your choice via the information area.
4. Press the button «Start Grouping»
To do the loting within a flight one should:
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1. Flight the necessary categories (which are included into a separate stream) in the list of categories.
2. Choose the operation type «Loting». Enter the initial number of the lot (the number to begin counting
with) (see picture 18).

3. Control your choice via the information area.

Loting b Grouping b
Begin from: The Groups: Mumber of groups:
1 % 1 % — 2 +
Picture 17 Picture 18

Press the button «Start Loting».

QUESTION 16. How the results of certain competition are exported into the protocol of other
competition?
Answer. Such a situation takes place, when within one competition a credit competition is given. In
such a case all the sportsmen take part in the first competition and only some of them are given a
credit of the second competition. The sportsmen who are given a credit in both competitions must be
marked in the main table of the first competition in the field «<Double» (See the picture on the left).
After the first competition it is necessary to create new competition (See QUESTION 3). It
is an empty pattern into which the data from the first competition will be exported.
The process of exporting is as follows:

Doubl - . .
| D & 1) Open the competition the data from which will be exported.

2) Show the window «Data export». You can do it with the help of:

—the menu item «Service > Export»;

— with help of the button of quick access 7 ;
— with the help of the key combination «Ctrl + Alt + E».

[]

H In the right panel of the window, which has just appeared, choose the name of the competition

into which the data should be exported (only the competitions compatible with the current ones
are displayed — See Picture 19).

Data export

Host country - city

> [E4

Competitions
European Masters Women's Championships
3rd Student's World Cup Single Championships

Kolomyia (Ukraine) ath Eurcpean Women Benchpress Open Champicnship
Competetion date Danube Cup
03.07.2002 - 03.07.2002 25th Women's World Champienships
15th World Open Women's Bench Press Championship
Competition 5th Masters Benchpress Championship Women

Women / Champianships / Ma 26th Women's World Open Championships

Z1=t Junior's European Powerlifting Championships
World Sub-junior Powerlifting Championships

World Junior Powerlifting Championships 3

’ [ Start data export ] ’ M cancel ]

Picture 19

Press the button «Start data export». There will appear a message which warns that the data of other
competitions (if they are already there — e.g. and you have made a mistake and have chosen the pattern
which is not empty) will be cancelled. If you have made a mistake press the button «No». If you have made
everything correctly and you are sure in your actions — press the button «Yes».

QUESTION 17. What is the purpose of the main and working tables?

Answer. The main table is used to register sportsmen in current competition, create and change information
(surname, first name of a sportsman, region (country, state, city), bodyweight, weight category etc. You may
transfer into the mode of the main table
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— having pressed the button of quick access ;

—having chosen the menu item «View > main table»;

—having used the key combination «Ctrl + M».

The working table is used to show the information during the first competition session (declared weight
in every attempt; good lift/ no lift etc.). You may transfer into the mode of the working table having chosen the
item menu «Show > Work table»; with the help of the quick access button ; the key combination
«Ctrl + W».

QUESTION 18. How should the competition session be set?

Answer. To set bodyweight categories (and groups) which are included into a certain competition session:
1) Form the sessions at the beginning of the competitions — choose the bodyweight categories (groups)
which are included into the same competition session. In this case press the button of quick access

. After this there will appear the window «Set competition session» (See Picture 20).

Set competition sessions

13th World Master's Women Championships

Main Stream Added Stream L
75; 82,5; 90; 90+kg /2 gr./ 75; 82,5; 90; 90+kg /1 gr./
75; 82,5; 90; 90+kg /1 gr./ 75; 82,5; 90; 90+kg /2 gr./

44; 48; 52; 56kg fall groups/

’ @ Remove ” {E Mew ’ Cane |E| ]

Picture 20

2) A session can consist of two streams — main and subsidiary (added). In any case the main competition
stream should be set. In this case press the button «New» and in the window of category choice, which
appears afterwards, mark the necessary categories (and group). If the session consist of two streams
move the cursor of the mouse on the appropriate line and press the left button. On the right in the input

field there will appear an editing button || |--], which you should also press on. Then choose the

necessary categories from the editor. It all the competition sessions are known from beginning, and
then they are to be input for further usage.

3)To set necessary session during the competition, press the left button of the mouse on the pointed
down arrow of the quick access button. In the just appeared menu choose the necessary session (See
Picture 21).

'ﬁ' 60kg f1 ar.f == 60kg /2 ar.f
§ 67,5 75; 82,5; 90kg /fall groups/
i 42: 52 56 60kg fall groups/

Picture 21

Note: A Competition session setting with the competition of two streams, when the additional stream is
used, is possible when the system operates as a network. In this case all categories will be displayed in
protocols (on the informational board). When the third attempt of a separate discipline is made by the first
stream, the information board «Lifting Order» will show the representatives of the next stream and their
lifting orders. As a rule there is at least a 3 minutes’ break (technical) between the disciplines of the compe-
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tition. That's why the following way of choosing the competition session is recommended:
e.g. the lifters of bodyweight category under 60kg take part in the session and the competitions are divided
into two streams: the first and the second groups of the category. Then the following pattern should be used:

ﬁ 60kg f1 gr./ == 60kg /2 gr.f ﬁ 60kg /1 gr.) == alkg f2 gr.f
§ e0kog/2ar/ or |§# 60kg/2gr/ == 60kg/1ar/

The choice of streams should be made in accordance with the stream which is on the platform. In this case
if the first group is on the platform, then choose the first menu item, if the second — the second.

QUESTION 19. How are the current discipline and the attempt set?
Answer. To set the current discipline use:

_ the button of quick access | "iI* |8 /8

(which indicates (one by one): squat, bench press, dead lift);
—with the help of the key combinations «SHIFT + Ctrl + F1» (squat), «SHIFT + Ctrl + F2» (bench press),
«SHIFT + Ctrl + F3» (dead lift).

To set a current attempt use:

— the button of quick access | [1] (4]

—the key combinations «SHIFT + Ctrl + F5» (1 at.), «<SHIFT + Ctrl + F6» (2 at.), «<SHIFT + Ctrl + F7»
(3 at.), «<SHIFT + Ctrl + F8» (4 at.).

QUESTION 20. How are current session, discipline, attempt found out?
Answer. Current session, discipline, attempt are displayed in the status bar of the program (at the bottom of
the main window — See Picture 22).

||§. Work table |'ﬁ" Sguat ||I| 1 attempt |@ 60kg fall groups/
Picture 22

QUESTION 21. How are the sportsmen who were eliminated (disqualified) from the competition taken

into account (their total is zero)?
Answer. To show the results of the competition correctly in the information tables (working table, score sheet
etc.) to take into account the lifting order of the sportsmen (those who have previously been eliminated from

the current session are included) you should press the quick access button () (or make use of key

combination «Ctrl + Z»). To exclude those who have been eliminated press the button one more time (retry
the key combination). The state (to include/exclude) is displayed on the status bar to the left of the current
session sign (See Picture 22).

QUESTION 22. How are the competition conducted with the help of the working table?
Answer. The working table is divided into two windows — upper and lower. The upper window is a
working one, here are the declared weight of bar, the notes about the successful attempts and
records (See Picture 23).

The lower window is an additional one and is used by the secretary of the competition. There is shown
the lifting order of the lifters and the state of weight declarations of the next attempt (See Picture 24).

This window can contract/expand/minimize with the help of the special button

| ESCETEEEEETrr Faaw
'Tlub B. weithd+ wei

R 8865 © 95
R B2B0 12C

(it's green in the picture) or by dragging it with the help of the mouse beyond the upper part of the window.

To fix the weight declared/submitted by the lifter in the working table choose the cell of necessary
attempt lifter’s row (which accords to his surname and name) and edit into the cell the weight value (mind
your moving from the cell - See QUESTION 6).
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Add. Info
/55 /69,70

Ratan Moni Roy Chowdary | IHD

4 |Diter Susanne DEN /52 /82,50
7 |Speth Eva GER /54 /87,80
15 |McKinlay Sonja UsL /43 /72,85
3 |Lehto Anne FIN /51 /&g8,10
17 |Thimm Anita GER /50 /67,90
10 |Hollands Susan GBR /51 /81,50 -82,5 170,0 130,00 182,55
Picture 23
| T - |
Mr. Sportzman Mation/Club B. weight  “#feight Lot Status
______ 1 ¢ Czecs Briska GER 8a8.65 45.0 7 to platform
2 SpethEwva GER g2.80 1200 14 next
3 “Wass Catherina GER 72,65 130.0 2
4 Thimm Anita GER 61.85 1300 3
5 Eeretta Donatella [T, B61.80 1326 12
5 FPonomarewa Tabyana RIS g0.50 1400 13
7 Tsukanowa Mataliva KR 71.90 1800 11

Picture 24

Completed attempts are made bold font, uncompleted attempts are not made bold (hormal). To note the
information about the successful attempts move the cursor of the mouse on the cell of lifter’s row with the
number of the appropriate attempt and click on it with the right button of the mouse. Choose one of the
possible variants in the popup menu which is to appear (See Picture 25):

ErmETRETART
n .Y 141 N n_n
revl® Goodlft ||

il H No lift

T & Undo attempt

i

| i
12t ¥ Refferee error 7
i

|

12: E3 Has refused

17 5 Remove of Doctor

@ Technical Disq.

« Doping Disq.
& Remove Disq.

Picture 25

Good lift —if the attempt is successful
No lift — if the attempt is unsuccessful
Undo attempt —undo completed attempt
Referee error —if the referees (loaders) have made a mistake and lifter is given an extra attempt
Has refused — if lifters refused attempt
Remove of doctor —the lifter is retired from the competition by doctor.
You may note of the completed attempt in another way. If the sportsman is active (on the platform; it is
marked in the upper row of the table) you may note it for the current discipline, current attempt with the help
of quick access buttons:

@ E @

(good lift, no lift, undo the attempt — accordingly) or with the help of the key combinations: F10 —good lift, F11
—no lift, F12 — undo the attempt.
Attention! To recalculate the results of the current session competition and prepare them to be output
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into protocols, press the button F9 or the quick access button " . It can be done at the end of the compe-
tition session, if the main server of the competition operates autonomously. If the system operates as a part

of the network system, then to show changes on the client computers you should press ' (or F9) each

time after editing data. if the system operates as a part of the network, the following quick access buttons
should be made use of:

| Rec2 | Rec4 | 5Q INFD W, & &
wm2

the 1st — operation changes (F9);
the 2nd — on competition of a separate discipline (SHIFT + F9);
the 3rd — on competition of session competitions (Ctrl + F9).

If a lifter sets up a record then you can make the note about it in the
column «Info» of the appropriate attempt (or total). You can choose the
| recordvalue from the dropping list (see the picture on the left).

(23

QUESTION 23. How can Wilks Formulae be changed?
Answer. Use:
—the menu item «Options > Preferences»;

— the quick access button -3 ;

—the key combination «Ctrl + Alt +P».

In the appeared window choose the bookmark «Wilks Formulae». In the column «B. weight» (marked
yellow) chooses the value of lifters bodyweight in kg. Then choose the column with necessary value in
grammas for the chosen row (e.g.: bodyweight 56.7 kg — row 56, column 0.7). The designation of the quick

access buttons

is one by one —male table; female table; table printing. (Note: To print the tables you should have MS Excel
installed on your computer).

QUESTION 24. How are protocols prepared and printed?

Answer. With the help of the GOODLIFT system you can prepare and print the complete set of documents
necessary to conduct the competitions. It is rather logic to arrange all the documents into 3 groups: initial,
current and final protocols. To print the necessary protocol choose the item of the main menu «Protocols»

(or press the quick access button =] = )® choose the group of protocols ® choose the title of the necessary
protocol (See Picture 26).

= Tnitial protocols : ©l| Speacker's cards

=1 Final protocols » £ Loting table
Bl Export to HTML » |&] Equipment table
B Assistant table

=l Scoresheet table

% Nomination

Picture 26

QUESTION 25. How are team points and the number of lifters counted for the team competition

changed?
Answer. Make use of:
—the menu item «Options > Preferences»;

— the quick access button -3 ;
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—the key combination «Ctrl + Alt +P».
In the appeared window choose the bookmark «Competition options». On the left choose the panel «Team
parameters». Team points are input in the following way:
1. Choose the row wit the placing the lifter takes (the left column, marked yellow).
2. Inthe right column input the value of the points for this row. To define the number of competitors from
a team, the point scores of which are counted for the team competition, choose the item «To team
points»

To team pointz B E sporkemen

and clicking on the up-down arrows with the cursor of the mouse, choose the necessary number.

QUESTION 26. How is the protocol header which is to be inputinto printing protocols changed?
Answer. Make use of:

—the menu item «Options > Preferences»;

— the quick access button -3 ;

—the key combination «Ctrl + Alt +P».
In the appeared window choose the bookmark «Competition options». In the right panel «Print protocol
parameters» complete two (or one) fields «Host federation/club» with necessary information.

Print protocols parameters

Hozt federationdclub

|Internatinnal Powerlifting Federation |

QUESTION 27. How is display of the lifter’s lotting number in the speaker’s cards allowed?
Answer. Make use of:
—the menu item «Options > Preferences»;

— the quick access button -3 ;

—the key combination «Ctrl + Alt +P».
In the appeared window choose the bookmark «Competition options». In the right panel «Print
protocol parameters» check/uncheck the tick in the field «<Automatic lot number description
in speaker’s card».

Automatic lob number description in zpeaker's card

QUESTION 28. How is display of the lifter’s record description in protocols?
Answer. Make use of:
—the menu item «Options > Preferences»;

— the quick access button -3 ;

— the key combination «Ctrl + Alt +P».
In the appeared window choose the bookmark «Competition options». In the right panel «Print
protocol parameters» check/uncheck the tick in the field «Output record description in
protocols».

Dutput record description in protocols

QUESTION 29. How are the GOODLIFT clients working in the network mode operated?
Answer. To control the clients included into the competition server make use of control mode (is
included only into Professional Edition and is excluded from Standard Edition). Make use of the
window «System network» to find access to its command (See Picture 27).
It may be shown via:

— choosing the menu item «Client > Net» ;

— with the help of the quick button #, ;
— with the help of the key combination «Ctrl + Alt + N».
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*r The GOODLIFT System Network

name address state

- SERVER 192.168.0.2 Loaders e-Assistent

[ &8 Recall clients ]

[@ Connect ] Done |5

[ $ | Disconnect ]

¢p connected

Picture 27

The Client Working Mode and the State of the Net:

& connected Main server of competition is active
# dizconnected Main server of competition is inactive
<{E| Connect
ﬂ Discorract No connect or disconnect with the clients make use of the button «Connect» and

«Disconnect»

& Fecall clients

To recall the clients about their working mode (is used, if the clients were run again
during the work of server (shutdown or restart).

The menu of switching the clients into different working modes. To switch the client into the appropriate
working mode with the help of the left button of the mouse choose the necessary computer from the list of the
computers which are the part of the network system and press the right button of the mouse. Choose the
necessary mode from the menu which has just appeared.

®= The GOODLIFT System Network

name address state

|"I- SERIUIER Bl T T Wl T T — [ I P J.__:_J.__t
& To awaiting .

4 Lifting order

(£ Presentation board
W Ceremony Board
M- Loaders e-Assistent
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Attention! If the main competition server is disconnected from the network the clients may continue to
operate in their modes. But if the computer which is the main competition server is being restart, then it is
necessary to stop and run all the client programs again.

QUESTION 30. How is the information board set and controlled?
Answer. To set the information board shows the window of setting parameters. To perform it makes use of:
—item menu «Clients > Information Board»;

— the combination of short keys «Ctrl + Alt + M».

The given software module allows to set separate elements of the information board and also color and
style of the board background. The module consists of two forms — the first one is the prototype of the board,
the second one is controlling, it allows setting the element chosen from the first form. The elements of
information board are textual labels into which certain information, which is to be shown on the information
board, is input. The elements of textual label which may be changed are the fonts, their size, color, style and
also the view of the element on the information board. The place of the element on the screen can be
changed if you choose (with the help of the mouse) the necessary element on the prototype form and drag it
across this form. The position of the element is shown on the control form. You can also choose the painting
style and the background color of the information board. To confirm the changes press the button «Apply»
using the mouse. Pressing the button «OK» you close the form and then you are brought to work with the
main (or working) competition table.

QUESTION 31. How are the font protocol parameters which are showed on the clients set?

Score Sheets Font EJ

Font name

Font size
10

-
-

[ & Apply H Done |5 ]

Picture 28

Answer. To set the font protocol parameters use the window «Score Sheet Font» (See Picture 28).
It can be shown:
—with the help of the menu item «Clients > Score Sheet Font»;

— the quick access button i ;

— the combination of short keys «Ctrl + Alt + F».
In this window the name and the size of font s chosen. To confirm the chosen changes press the button

<Apply».

QUESTION 32. How is aline of atext shown on the information board?
Answer. First of all show the control window «Information Line» (See Picture 29). To perform it makes use
of:

—the item menu «Clients > Information Line»;

— the quick access button ;

—the key combination «Ctrl + Alt + I».

Information Line is shown only on the client computers, which operate in the mode of Information
Board. You can show two lines (complete two input fields «Line» in the window «Information Line», set font
parameters («Font») and blinking interval (in seconds) . If a message should be shown without blinking
effect, value the interval at ‘0’. After the button «Run» has been pressed on the message will be displayed on
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